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Getting Started 
Introduction 
This manual has been written to highlight the processes which may be useful to design, model and prepare a 
set of roadway plans for an SCDOT project. While every effort was made to include all relevant information, the 
Autodesk Civil3D software has a multitude of tools available which cannot all be explained within this manual. 
As you develop your knowledge of the software it may be useful to seek additional instruction outside of this 
manual. The AutoCAD and Civil3D software’s both have extensive documentation provided by Autodesk (see 
the links below). Civil3D is an extension built on top of the AutoCAD software, meaning it contains all the core 
functionalities of AutoCAD but adds specialized tools and features specifically for civil engineering and 
infrastructure projects, such as terrain modeling, road design, and drainage analysis. Therefore, some of the 
more basic CAD functionalities such as lines, arcs, layers, move, copy etc. would be covered in the AutoCAD 
documentation rather than the Civil3D documentation. 

AutoCAD: https://help.autodesk.com/view/ACD/2026/ENU/ 

Civil3D: https://help.autodesk.com/view/CIV3D/2026/ENU/ 

* Another opportunity to acquaint yourself with the software is through the training and tutorials provided by 
Autodesk. These include written documentation and provide workflows paired with example files that are 
downloaded when the program is installed.  

 Autodesk Learning – Video tutorials providing high level overview of program capabilities. 

Autodesk Civil 3D Online Tutorials – Written tutorials paired with sample drawings.  

Tutorial Folder Locations 

Tutorial dwg files: C:\Program Files\Autodesk\AutoCAD 2026\C3D\Help\Civil Tutorials\Drawings  

Manual Formatting 
Throughout this manual some text formatting has been adjusted to help highlight specific items. 

Any Command line prompts will be formatted like this to help direct your attention to the 
command line for the next step in a workflow. 

* Any information considered to be guidance or suggestion rather than a strict workflow or description will be 
formatted like this. 

Open Civil 3D 
Start the Civil 3D 2026 application by double-clicking the Civil 3D 2026 Imperial or the Civil 3D 2026 SCDOT 
icon if available on your desktop or select the program through the Start Menu. 

    

Civil 3D 2026 Desktop Shortcuts 

https://help.autodesk.com/view/ACD/2026/ENU/
https://help.autodesk.com/view/CIV3D/2026/ENU/
https://www.autodesk.com/learn
https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-B6CF98F9-FF6F-4FF5-8022-60EB21A611A7
https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-DECD2305-4906-4329-A973-CFC9B625B4CD#GUID-DECD2305-4906-4329-A973-CFC9B625B4CD__WS1A9193826455F5FF-7F10494411F03A24F2421E
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After the application loads you should see the screen below. This is known as the Start tab. 

 

 

1. If you select the “+” sign next to the Start tab, you will create a new drawing. This will be 
discussed in more detail later in this manual. 

2. Open: This selection allows you to open an existing drawing (both locally or web and mobile-
based), access Sheet Set Manager, or open sample files. 

3. New: This selection allows you to create new drawings and sheet sets. 
4. Recent: Shows most recently opened files for ease of access. You have a choice between 

“List View” and “Grid View” by clicking the 3 lines or the 4 squares, respectively. These are 
located under “Recent” and to the left of “Sort by”. 

* Files may be temporarily removed from this list by right-clicking on them and selecting “Remove from list”. If 
there are multiple files with the same name at different locations, the file path can be checked via the computer 
icon below the date associated with the file.  

5. Sort by: You may organize the list by “Last Opened” or by “Name”. 
6. Search: You may search for the file(s) you are looking for by name. 

Make a new drawing by clicking the “+” next to the Start tab as shown below: 
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This will create a new drawing titled “Drawing 1”. 

AutoCAD User Profiles 
* The information presented in this section should be used to form a general understanding of AutoCAD User 
Profiles. Specifics of how this is setup may vary for internal SCDOT staff vs. external consultants. 

AutoCAD User Profiles save personalized settings, like colors, fonts, cursor size, and standard filepath 
locations, allowing the ability to quickly switch environments for different projects or share settings across 
computers and organizations. Profiles can be managed either by right clicking in the middle of the screen and 
selecting Options or by typing “OP” in the command line then pressing enter. 

 

1. Switch to the Profiles tab within the Options dialog. 
2. Select the appropriate profile. C3D_Imperial, C3D_Metric, and AutoCAD are all generic profiles setup 

and provided by Autodesk. Any additional profiles listed would be custom profiles setup by your 
organization.  

3. After choosing the appropriate profile select “Set Current” 
4. Select “OK” 
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* Depending on your organizations setup the user profile may automatically be set when Civil 3D starts up. 

Interface 
The items below will be described in more detail to provide a brief overview of how to navigate the interface. 
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Application Menu 
Select the Civil 3D icon in the top-left corner of the screen.  

 

After clicking on the icon, you will see a list of options. 
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1. New: This selection allows you to create new drawings and sheet sets. 
2. Open: This selection allows you to open an existing drawing (both locally or web and mobile-

based), access Sheet Set Manager, import DGN files (Microstation format), import Industry-
Foundation Class (IFC) files and open sample files. 

3. Save: This allows you to perform a quick save of their current drawing. The shortcut for this is 
CTRL + S. 

4. Save As: This allows you to save their current drawing as another drawing, drawing template 
file, drawing standards file, other formatted files (that is, DWG, DWT, DWS, and DXF), save 
the layout as a drawing file, and DWG Convert which will allow us to save to a DWG format 
that is compatible with earlier releases of Civil 3D. 

Update relative paths is (recommended) when performing save as 

  
 

5. Export: This allows you to export their current drawing to a DWF, DWFx, 3D DWF, another 
DWG version, DGN, DXF, PDF, IFC, and other file formats (that is, WMF, SAT, STL, EPS, 
DXX, BMP, IGES and IGS). 

6. Publish: This allows you to access the Send to Print service, Archive, eTransmit, Email, and 
Share View. 

7. Print: This allows you to access Plot, Batch Plot, Plot Preview, View Plot and Publish Details, 
Page Setup, 3D Print, Manage Plotter, Manage Plot Styles, and Edit Plot Style Tables. 

8. Drawing Utilities: This allows you to access Drawing Properties, DWG Compare, Drawing 
Settings, Units, Audit, Status, Purge, Recover, Open the Drawing Recovery Manager, and 
Update Block Icons. 

9. Close: This closes the current drawing or all drawings (user’s choice). 
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Quick Access Toolbar 

 

To the right of the Civil 3D icon, there are a set of options that will make editing and saving files easy 
and intuitive to use. This section of icons is known as the Quick Access Toolbar. Here, many of the 
same options available in the application menu are available as quick-select icons for tools and 
functions that are common to everyday workflows.  

From left to right, they are as follows: 

New, Open, and Save are the first 3 which have already been discussed previously. 

Open from Web & Mobile: Open an existing drawing from AutoCAD Web & Mobile 

Save to Web & Mobile: Saves the current drawing to AutoCAD & Mobile. 

Plot: Prints a drawing to a plotter, printer or file. 

Undo: Allows the user to reverse any action that was previously done. The shortcut for this action is 
CTRL + Z. 

Redo: Allows the user to redo any undo that has occurred. The shortcut for this action is CTRL + Y. 

Workspace: Here you can change the tools available in the ribbons on the third and fourth levels 
depending on the type of design and analysis you are looking to perform within the current drawing. It 
is located to the right of the Undo and Redo icons at the top left of the screen. 
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Workspaces displayed and available include the following:  

• Civil 3D: Tools displayed in the ribbon will provide you with the bulk of the tools necessary to 
perform civil engineering design and analysis. 

• Drafting & Annotation: Tools displayed in the ribbon will provide you with the basic 2D 
drafting tools and functionality native to the AutoCAD environment. 

• 3D Modeling: Tools displayed in the ribbon will provide you with the basic 3D modeling tools 
and functionality. It’s important to note that 3D modeling capabilities within this display are not 
Civil 3D-related but are more intended for basic AutoCAD functionality. 

• Planning and Analysis: Tools displayed in the ribbon will provide you with additional mapping 
and analysis tools. These tools come in handy when connecting to ArcGIS data or when 
adding a basemap to the drawing. 

• Save Current As…: Provides the ability to save any customizations you have made to a 
customized workspace that can be made current later on. 

• Workspace Settings: Selecting this option will pull up another dialog box that will allow you to 
define which workspaces are available, as well as the display order of the workspaces listed. 

• Customize: Selecting this option will pull up another dialog box that will allow you to customize 
any of your workspaces if necessary. This will come in handy if you intend to create custom 
tools, layouts, and so on specific to your workflow. 

Customize Quick Access Toolbar: Directly next to the workspace selections is another down arrow with a 
horizontal line above it. If you select this, you will be presented with a drop-down menu that will provide the 
ability to select the tools available within the Quick Access Toolbar interface:  
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Those items that are checked will be displayed in the Quick Access Toolbar in your current view. 

Ribbon 
The ribbon is where icons for tools and commands are housed. It is separated into three different areas: tabs, 
panels, commands. 

 

* When an object is selected an additional “Contextual” tab will be added to the tab list with relevant panels and 
tools. 

 

Toolspace 
The next part of the user interface is the Toolspace. This can be accessed by going to the Home tab and 
selecting the Toolspace icon in the Palettes panel. Once activated, you’ll notice TOOLSPACE being displayed 
along the left-hand side of your session.  
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Within the TOOLSPACE there are many file and design management tools allowing granular control over 
design geometry and display. Along the right-hand side of the TOOLSPACE area, there are four individual tabs 
that will give access to different functionalities: Prospector, Settings, Survey and Toolbox. These can be 
toggled on and off in the Home tab Palettes panel of the ribbon. 
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Prospector: Provides you with the ability to create, modify, analyze and manage modeled geometry and 
components within your drawing(s) open in the current session as well as link modeled geometry and 
components from other files via Data Shortcuts Manager. 

Settings: Provides you with the ability to create, modify, and manage settings specific to the drawing(s) open 
in the current session. 

Survey: Provides you with the ability to connect to survey databases and manage configurations to streamline 
the integration of data within Autodesk’s Civil 3D platform. 

Toolbox: Provides you with additional reporting and analysis tools that work well for gathering information 
within the current drawing and exporting data to various reporting formats.  
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Drawing Area 
Moving on, the next area is the drawing area, which is fairly straightforward. This area is reserved for your 
design modeling, annotating, and so on. This is the visual space where you see your model and other 
elements like layouts (paper space). It's essentially the canvas where you view and interact with the model 
space and layout tabs. When you switch between different layouts, the drawing area dynamically updates to 
display the selected layout's content. All your work will be displayed in this area and will appear as shown in 
this screenshot: 

 

You’ll notice, however, a few different icons within your drawing area that are worth pointing out and providing 
a little more detail on. In the upper left-hand corner, you’ll notice a few view descriptions, similar to [-][Top][2D 
Wireframe]. When you select each of these fields, you are presented with the ability to further manage and/or 
change the display of all objects displayed in the drawing area.  
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If you select the first field, [-], you are presented with a few options to customize the drawing area, or model 
space viewport. The viewport configuration list provides the ability to split the drawing area into multiple views. 

 

 

If you select the second field, [Top], you are presented with a few options to customize the orientation of the 
view being displayed within your model space viewport:  

 

 



 

14 

If you select the third field, [2D Wireframe], you are presented with the ability to change the overall display of 
your model geometry and components within the model space viewport: 

 

Let’s move over to the upper right-hand corner of your drawing area. This is where you’ll find ViewCube which 
allows you to quickly change the user coordinate system (UCS) and view orientation of components 
displayed in your drawing area. By selecting any of the lettered directions or the rotation options in the top 
right, or selecting any location on the square/cube located in the center, the view orientation will update as you 
select each of the options. 

   

Just underneath ViewCube, you’ll notice a Quick View Access Bar. On this bar are additional options for 
navigating the drawing. We have the ability to quickly pull up the Full Navigation Wheel that will display right 
next to your mouse, pan across your drawing (represented by the hand icon), zoom in/out of your view, 
orbit/rotate your view along an axis, and ShowMotion, which allows you to create animations. 

Command Line 
The command line serves as a central location for controlling Civil 3D through text input, providing an efficient 
alternative or supplement to using the ribbon or toolbars. Although most tools/commands can be found in the 
various ribbons or toolbars, some users may find it more efficient to input certain commands as text in the 
command line. The command line also acts as a source for prompts and feedback, guiding users through each 
step of a command once it has been started. 
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It’s important to keep an eye on the command line while working if there is doubt as to what the next action 
needs to be. Any time there is an active command, and no dialog box presented, the next steps for the 
command will be displayed at the command line. 

* The command line window can be resized to display more information as needed. 

Model Space and Paper Space 
Civil 3D utilizes two distinct environments: Model Space for creating 3D or 2D designs at 1:1 scale, and Paper 
Space (Layouts) for arranging, scaling, and plotting these designs onto sheets. It is important to understand 
the difference between these two environments before starting design in order to organize the project files and 
sheets correctly for a project. 

Model Space: 
The Civil 3D Model Space is an infinite, 3D environment used for drafting, designing, and modeling objects at a 
1:1, real-world scale. It serves as the primary workspace for creating and modifying geometry and is accessed 
via the "Model" tab. 

 

Paper Space: 
The Civil 3D Paper Space is a sheet environment designed for organizing, scaling, annotating, and plotting 
drawings. Paper space allows users to arrange viewport windows, insert title blocks, and set print scales 
without affecting the actual model geometry. Viewport windows are an object acting as a "window" from paper 
space into model space to display drawings at specific scales. By default the paper space can be accessed via 
the “Layout” tab(s). However, the layout tabs can be renamed so there may be organization or project specific 
naming conventions for layout tabs. 

 

* It is important to note that while in a layout tab the model space can still be accessed and edited through the 
viewport. 

 

Status Bar 
The status bar is located in the lower right-hand corner of the screen. While the name would indicate that the 
items here are only to provide information, they are actually interactive to aid the design process. Some items 
are highlighted below but more information for each item can be found online at Status Bar Quick Reference. 

 

 or   Model or Paper Space – This is an indicator of whether the drawing is currently in model or 
paper space but can be used as a toggle to switch to the other as well. While in a layout tab it is important to 
note which “space” the drawing is in because errors could quickly arise while working in the wrong “space”. 

  2D Object Snap – Object snap allows the ability to snap to certain points such as perpendicular, 
endpoint, intersection, etc. while drawing. This is a toggle to turn that function on and off and the arrow to the 
right provides the ability to select which point types to snap to. 

https://help.autodesk.com/view/ACD/2026/ENU/?guid=GUID-E3B34B0A-EA98-45E9-937A-BF5FEF4152DB
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  Selection Cycling – Selection cycling becomes more useful as design progresses and multiple objects 
are in close proximity or coexist in the same location. With selection cycling turned on, once an object is 
selected a menu appears with a listing of all the objects available at that location. Only the object chosen from 
the list will be selected. If there is only one object present at the selection location the list will not populate. 

   

  Annotation Scale – Sets the scale for annotations while in the model tab. 

  Viewport Scale – Sets the scale for a specific viewport while in a layout tab.  

 or   Viewport Lock – Locks the scale and location of a specific viewport while in a layout tab. 

  Customization – Opens a list of all the available status bar items and a toggle for their display. 
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Layers and Styles in Civil 3D 
In Civil 3D the settings of layers and styles are commingled, and both influence how objects are displayed in 
the drawing at any given time. Layers are used to organize drawing data and manage visibility (on/off, 
freeze/thaw) while styles control how civil objects appear by overriding typical layer behaviors and providing 
granular control with the use of object component layers. For civil objects such as surfaces and alignments it is 
also very quick and easy to switch between different named styles, allowing flexibility in how objects are 
displayed. 

Layer Display 
Turning layers on/off and freezing/thawing layers both control object visibility, but freezing layers offers 
performance benefits in complex drawings. 

In the “Home” tab in the “Layers” palette go to “Layer Properties” 

When you left-click Layer Properties, the following window will appear: 

 

- On/Off: Turning a layer off makes its objects invisible but still considers them during 
regeneration (like when zooming or using certain commands). Use turning layers on/off for 
visual clarity and when you need to occasionally reference objects on those layers. 

- Freezing/Thawing: Freezing a layer, on the other hand, makes its objects invisible and 
excludes them from regeneration, resulting in faster operations. Thawing does the opposite. 
Use freezing/thawing layers when you need to improve performance in complex drawings or 
when you don't need to see or interact with objects on certain layers. 
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Object Layer(s) 
Each object in Autodesk Civil 3D has a layer on which the object physically resides. For simpler objects such 
as lines, arcs, text, etc the object visibility will only be tied to the assigned layer. Certain civil objects that are 
more complex have an object base layer on which the object physically resides, and object component layers 
that control the display of object components. See Appendix A for a list of objects that use the base layer plus 
component layer setup. 
* Object Layers and Object Styles have been presented at the beginning of the manual because they are 
applicable to the display of objects while interacting within Civil 3D. However, it may be best to revisit this 
section as you progress through this manual as certain information described here may make more sense with 
additional experience using the program. 

Object Base Layer 
Default base layers for objects are specified on the Object Layers tab of the Drawing Settings dialog box. 
When creating an object, the default layer can be accepted or a new layer can be specified. 
* Under most circumstances the default layer should be accepted. 
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Object Component Layers 
The component layers are defined in the Display tab of the Object Styles dialog box. The component layers 
allow you to work with objects as if parts of them are located on different layers. 
* There is not a single Object Styles dialog box. Each object type has a dialog box where display settings can 
be accessed. An example is shown below. 

To access the object styles for a specific type of object, in the Toolspace select the Settings tab. Then under 
the styles folder for the object (e.g. Surface) right-click on the specific style and click edit. 

 

 

Objects are physically created on the base layer, but the display of components is governed by the associated 
component layers. Each object component uses the visibility settings for the component layer (such as on/off), 
as well as the color, linetype, lineweight, and plot style for the layer if the various Component Display settings 
are set to ByLayer. 
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* Layer 0 has a special meaning in the Component Display settings. When the layer is set to 0, the object base 
layer is used for that component. For example, if the alignment base layer is OJ-ALGN, and the layer for the 
Line component is set to 0, then the alignment lines behave as if they are located on layer OJ-ALGN. 

  

A good example of how these layer types interact is with a surface object. If the surface base layer is frozen, 
the display of all surface components is not visible. If individual object component layers are frozen only the 
display for the selected components are not visible. See examples below. 

     
Base and Component Layers Thawed  Surface Base Layer Frozen 
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Surface Annotation Base Layer Frozen  Surface Mesh, Spots and Flow Direction 
       Component Layers Frozen 

Object Styles 
Objects in Civil 3D are the intelligent and dynamic design components such as points, surfaces, alignments, 
profiles, and corridors that represent modeled features. Each of these object types can have multiple styles 
available for use that will change how the object is displayed in various views such as plan, model, profile, and 
section. Object styles only adjust the display of the object itself, labels have their own styles that are managed 
elsewhere. 

Point Styles 
Point styles have been developed that correspond with SCDOT survey point codes. If survey is processed 
using Civil 3D, survey points should have an associated point style.  

Surface Styles 
Surface styles have been developed to highlight different surface elements that may be needed by designers. 
These have been listed below with a brief description.  

Boundary (Existing) – Displays only the boundary of a surface. To be used with existing surfaces. 

Boundary (Proposed) – Displays only the boundary of a surface. To be used with proposed surfaces. 

Contours 1' & 5' (Existing) – Displays contours at 1’ minor and 5’ major intervals and the boundary of a 
surface. To be used with existing surfaces. 

Contours 1' & 5' (Proposed) – Displays contours at 1’ minor and 5’ major intervals and the boundary of a 
surface. To be used with proposed surfaces. 

Elevation Banding (2D) – Displays colored banding in 2D to represent the relative elevation of a surface. 
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Slope Arrows (Existing) – Displays slope arrows corresponding with each triangle face as well as 5’ major 
contours of a surface. To be used with existing surfaces. 

Slope Arrows (Proposed) – Displays slope arrows corresponding with each triangle face as well as 5’ major 
contours of a surface. To be used with proposed surfaces. 

Triangles (Existing) – Displays triangle faces and the boundary of a surface. To be used with existing 
surfaces. 

Triangles (Proposed) – Displays triangle faces and the boundary of a surface. To be used with proposed 
surfaces. 

Watersheds – Displays the separate watersheds within a surface with some basic details if a watershed 
analysis has been run for a surface. 

Alignment Styles 
Alignment styles have been developed for surveyed alignments and relocated alignments with relocated 
alignments defaulting to a dashed linetype. 

Profile Styles 
Profile styles have been developed for multiple different uses a designer may have. These have been listed 
below with a brief description. 

Proposed Profile – To be used for a finalized proposed profile. 

Sketch Profile [1] – To be used for drafting alternatives as needed. 

Sketch Profile [2] – To be used for drafting alternatives as needed. 

Surveyed Ground – To be used for the existing ground profile along the centerline of an alignment. 

Surveyed Ground - Left – To be used for the left side of a triple profile. 

Surveyed Ground - Right – To be used for the right side of a triple profile. 

Corridor Styles 
Corridor Styles control the corridor information that is displayed at elevation zero and helps provide clarity on 
the location and edits made to a corridor. Code set styles control the display of the individual parts of a corridor 
as it is modeled. 

Code Set Styles 
Code set styles are a comprehensive style that combine marker, link, and shape styles to define how corridor 
components are displayed. As point, link, and shape codes are defined in the subassembly and assembly 
creation process the specific codes provided for these elements will influence how the elements display in the 
corridor. Code set styles are capable of influencing the display of elements in plan, model, profile, and section 
views. The Corridor code set style has been setup as the primary code set style for use with subassemblies, 
assemblies and corridors. 
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Basic Editing Tools 
The tools discussed in this section are the more basic tools that would primarily be available with a base 
AutoCAD installation without the Civil 3D components. This section is intended to only provide a brief overview 
of these tools and how to access them. 

Draw Panel 
The Draw Panel is on the home tab and contains tools such as line, arc, polyline, circle, rectangle, etc. 

 

* As you become more familiar with the Civil 3D program you will most likely find that polylines are a very 
useful and flexible object to use. The command for a polyline is PL or (PLINE). 

Modify Panel 
The Modify Panel is on the home tab and contains tools such as move, copy, rotate, mirror, scale, trim, extend, 
fillet, etc. 

  

* You may find it easier to use the commands for some of the tools which are used more frequently. 
Move – M or (MOVE) 
Copy – CO or (COPY) 
Rotate – RO or (ROTATE) 
Trim – TR or (TRIM) 
Extend – EX or (EXTEND) 

Text Panel 
The Text Panel is on the annotate tab and contains tools such as multiline text, single line text, spell check, 
text styles, a text search function, etc. 
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Leaders Panel 
The Leaders Panel is on the annotate tab and contains tools such as multileader, add leader, remove leader, 
multileader styles, etc. 

 

Properties Palette 
The properties palette is on the home tab on the palettes panel and can also be accessed with the keyboard 
shortcut (Ctrl + 1). With the properties palette open if an object is selected, all the objects specific properties 
can be seen and certain properties can be edited. 

 

* The escape button is your friend. Just hit the escape button to get out of any object selection or command. 

Examples: Polyline, Alignment, Surface, Text 

 



 

25 
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* Hovering over any object will provide a small snippet of property information and usually includes Name, 
Style, Layer, and object specific information. 

           

 

Transparent Commands 
Transparent commands in Civil 3D allow for precise object placement (e.g., station/offset, bearing/distance) 
while another command is active. They can be accessed via the Transparent tab, or by typing the command 
prefixed with an apostrophe, ('BD for Bearing Distance, ‘SO for Station Offset, etc.) in the command line. They 
enable uninterrupted workflows for creating Civil 3D objects. 
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Example: 
1. Start another command (for this example we will use PLINE) 
2. Follow command line prompt: PLINE specify start point: 
3. Enter transparent command: ‘BD 
4. Follow command line prompt: BD >>Specify Quadrant (1-4): 
5. Follow command line prompt: BD >>Specify bearing: 
6. Follow command line prompt: BD >>Specify distance: 
7. Continue to add additional line segments or press enter to escape ‘BD transparent command. 

* Hovering over the tool command in the ribbon also provides instruction on how to use the tool. 
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Managing External Data 
While progressing through a project it will be necessary to reference or add information to your files from 
multiple different sources. External references, data shortcuts, and copying objects are all methods for adding 
information to a current drawing from another drawing. External references focus on attaching source 
information in the same manner it is shown in the source drawing. Data Shortcuts focus on design objects and 
have more flexibility in terms of presenting how the objects are displayed in the current drawing. Copying 
objects places the object in the current drawing for manipulation. 

* External References and Data Shortcuts have been presented at the beginning of the manual because they 
may be applicable to many operations within Civil 3D. However, it may be best to revisit this section as you 
progress through this manual when the topic at hand involves xrefs or data shortcuts. 

Add External References 
An External Reference (XREF) in Civil 3D is a link to another file (like a DWG, PDF, or image) that appears in 
your current drawing as an overlay, keeping your current file size small and enabling collaboration by letting 
different users work on separate components. Existing data (like survey data or alignment layouts) can be 
referenced without embedding the actual content, so changes to the referenced “source” file automatically 
update in all drawings that use it. 

Typing the command XREF into the command line will open the external reference manager. The current 
drawing will be displayed in the list. 

 

To attach an external reference select the dropdown in the top left corner and for most cases use the Attach 
DWG option. Select another file type if necessary. 
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Select the file that is to be referenced from the file explorer. 

 

1. Reference Type: Overlay references only carry the information in the source file to the current file. 
Attachment reference will carry the source file information as well as any references to the source file. 
Using overlay references is generally recommended to prevent circular references and file bloat. 

2. Locate Using Geographic Data: For this to be available both the source and current drawing have to 
have a coordinate system set. If that is the case, selecting this will remove all other options except Path 
type and the coordinate systems will be used to align the files. 

3. Scale: The scale can be adjusted here or specified on screen in each axis direction. Best practice 
would be to leave as 1.  

4. Insertion point: The base point from the source drawing will be aligned with the coordinate specified 
here. Best practice is to maintain at 0,0,0. 

5. Path Type: No path will allow the current drawing to search only in its current folder for the given 
filename. Relative path will assume any referenced files are still in the same relative folder location 
even if an earlier portion of a file path has changed (ie. parent folder or adjacent folder to current 
drawing). Full path will search for the source drawing only at the full path given when attached. Best 
practice is to leave this set to relative path. 

6. Rotation: This will rotate the source drawing by the angle specified either here or on screen. Best 
practice is to maintain at zero degrees. 

7. Select OK to attach the reference. 
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Right click on the external reference for additional options. 

 

Unload: The referenced drawing can be removed from being displayed but still retained as an attachment for 
future use. 

Reload: If the referenced drawing has been unloaded this will return it to a displayed status. 

Detach: The referenced drawing can be removed from the current drawing as an attachment. 

Bind: See Copy Entire Drawing below. 

Copy Objects from External Files 
There are multiple different ways to copy objects between files. Three options will be described here with 
slightly different scopes, there may be other methods as well. 

Copy Entire Drawing 
One method to copy an entire drawing into your current drawing is to attach the desired drawing as an external 
reference as previously discussed and then use the bind option. 

1. Attach the desired drawing as an external reference. 
2. Right click on the external reference in the external reference manager and select Bind. 

Bind will bring the objects from the reference file into the current drawing as live objects. There are two options 
for bind type (Bind or Insert).  

• Bind will add a prefix to the layer name of the objects originating from the external reference thereby 
maintaining the integrity of objects from both drawings 

• Insert will merge external reference layers with layers in the current drawing if they match and adopt the 
current drawings properties. 

Copy Multiple Objects 
One method to copy multiple objects into your current drawing is to open the drawing with the desired objects 
in a separate instance then use the COPYBASE command starting from that drawing. 

1. Start the COPYBASE command 
2. Follow command line prompt: COPYBASE Specify base point: 
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* Select a point that is known in the second drawing or type 0,0,0 
3. Follow command line prompt: COPYBASE Select objects: 
4. Press enter once all desired objects have been selected 
5. Switch to the current drawing and select paste from the home tab or use the keyboard shortcut (Ctrl + V) 

 
6. Follow command line prompt: PASTECLIP _pasteclip Specify insertion point: 

* Use the same point specified in step 2. 
7. The objects should be copied into the current drawing. 

Copy One Object 
One method to copy a single object into your current drawing is to attach the desired drawing as an external 
reference as previously discussed and then use the NCOPY command.  

1. Attach the desired drawing as an external reference. 
2. Start the NCOPY command 
3. Follow command line prompt: NCOPY Select nested objects to copy or [Settings]: 

* This command can handle multiple objects but each has to be added individually so it becomes 
inefficient for more than a few items. 

4. Follow command line prompt: NCOPY Specify base point or [Displacement Multiple] 
<Displacement>: 

5. Follow command line prompt: NCOPY Specify second point or [Array] <use first point as 
displacement>: 

6. The object should be copied into the current drawing. 

Create Data Shortcuts 
In AutoCAD Civil 3D, data shortcuts provide a way to reference and share Civil 3D objects between different 
drawings without duplicating the objects. Data shortcuts can be used for Surfaces, Alignments (including 
profiles), Pipe Networks, Pressure Networks, Corridors, and View Frame Groups. By creating a shortcut to an 
object in a “source” drawing, other drawings can link to that object and receive automatic updates if the original 
is modified in the “source” drawing.  

How Data Shortcuts Work 

1. Create Objects: You create your main Civil 3D objects (e.g., an existing ground surface, an alignment, etc.) 
in a dedicated "source" drawing.  

2. Create Data Shortcut: Within that “source” drawing's Toolspace, you right-click on the object and select 
"Create Data Shortcut". 

3. Reference Objects: In other "consumer" drawings, you can reference the data shortcut. The linked object 
appears in the “consumer” drawing and it’s display can be manipulated using object styles, but its data remains 
stored in the original “source” drawing. The object cannot be edited from the “consumer” drawing. 

4. Dynamic Updates: If the “source” object is edited in the “source” drawing, the data shortcuts in all referenced 
drawings will show the changes, enabling synchronized project updates. 
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Below are the steps to setup data shortcut folders, add new data shortcuts, and reference the objects into a 
“consumer” drawing. Depending on whether this is a new project or one that has been worked on previously 
you may not have to complete all of these steps. 
 

Set Working Folder 
Right click on Data Shortcuts [ ] towards the bottom of the prospector tab in toolspace. 

   
 
Select Set Working Folder (Your working directory) 

 
The working folder will typically be the one that holds all the different disciplines design files or somewhere 
similar that any project designers would have read/write access to. 
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The working folder will be one level above the project folder setup in the next step. If the project folder has 
been setup previously, you may be able to skip directly to step 3 after completing this step. 

Set Data Shortcuts Project Folder 
For this step you will either need to use New Data Shortcuts Project Folder or Set Data Shortcuts Project 
Folder 

a) New Data Shortcuts Project Folder 

This step will only need to be completed once for a project, if a project folder has been setup skip to b) below 
to set the Project Folder 

Right click on Data Shortcuts [ ]. 

Select New Data Shortcuts Project Folder… 

 
The working folder should be filled out with the working folder that was just created or selected. Provide the 
name “Data Shortcuts” for the project folder then press OK. 
A folder named “Data Shortcuts” will be created within the Working Folder setup previously. 
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If the name you provide for a folder already exists you will get an error message and you should instead follow 
the instructions in the next section. 

 
b) Set Data Shortcuts Project Folder 

Right click on Data Shortcuts [ ]. 

Select Set Data Shortcuts Project Folder… 
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The dialog box below will populate with multiple Project Folders if available. Select the appropriate 

 

Create Data Shortcut in “source” drawing 
If you have any of the items listed below that need to be made available to the rest of the design team a Data 
Shortcut can be created by following the steps below. 

Surfaces 
Alignments (including profiles) 
Pipe Networks 
Pressure Networks 
Corridors 
View Frame Groups 

Right click on Data Shortcuts [ ]. 

Select Create Data Shortcuts 
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This dialog will pop up with all available objects in the drawing. Select only the appropriate objects and press 
OK. 

 
 
Now if you expand the appropriate categories under Data Shortcuts [ ] you will see the objects you just 
added. 

 
 

Access Data Shortcuts from “consumer” drawings 
Once a data shortcut has been created it can be accessed from any “consumer” drawing where the same 
working folder and project folder combination have been selected.  
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Open the “consumer” drawing by either starting a new file or open an existing file where project design data 
needs to be linked. See previous steps if working folder and project folder combination are not set to desired 
location. 

Under Data Shortcuts [ ] right click on the object that needs to be linked and select Create Reference 

 

The name, description, style, and render material can all be adjusted if needed or left as is. These can also be 
changed later via the surface properties menu if needed. Select OK to add the object to the “consumer” 
drawing. 

 
 
The object should now be available in the in the prospector tab within your “consumer” drawing. Note the 
shortcut symbol to the left of the object name. 
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Design 
File Management/File Federation 
In Civil 3D the objects displayed and used for design are interconnected and reference each other for 
information. While it is possible to build an entire project within one file (survey data, alignments, profiles, 
subassemblies, cross sections, etc.), it is recommended to split these design elements into different files to 
allow multiple users access for design work, keep individual file sizes lower, and provide redundancy in case a 
file becomes corrupt. The divisions below are suggested based on how the Civil 3D program has been setup to 
use external references and data shortcuts to share design information. 

 

 

Folder Naming Conventions 
TBD 

File Naming Conventions 
TBD 
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Setting up a New File 
Open Civil 3D using the Civil 3D 2026 SCDOT Shortcut 
Start the Civil 3D 2026 application by double-clicking the Civil 3D 2026 Imperial or the Civil 3D 2026 SCDOT 
icon if available on your desktop or select the program through the Start Menu. 

 

Select: New 

 
Select: SCDOT 2026 Template.dwt 
 *If this template does not display see the SCDOT Profile section of this manual 
Perform a Save As and name the drawing appropriately.  
 
This process will be used to create any new drawings needed while working on a project. It is preferred that 
new drawings be created rather than using save as. This helps eliminate duplicate information and 
unnecessary linework that may lead to confusion. In addition within the Civil 3D environment it is essential to 
reduce the opportunity for files to be referring to duplicate or incorrect objects. 
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Setup Project Survey 
SCDOT is accepting survey deliverables in the following “native” filetypes Carlson (.dwg), Civil 3D (.dwg), and 
OpenRoads (.dgn) formats. Therefore, survey setup for projects may look slightly different depending on how 
the project survey was initially processed. Regardless of which program the survey was “natively” delivered in 
there should also be the following “neutral” files delivered with the survey, an ascii (.txt) file(s) with point 
information and multiple (.xml) files with point, alignment and surface information. These additional “neutral” file 
types will be utilized to help support the survey setup and provide a means of communication between the 
different softwares. 

2D Planimetrics 
For 2D planimetrics the suggested best practice is to create a copy of the delivered native file into a central 
folder where it accessible to project designers. This file can then be externally referenced into Civil 3D to be 
used as a visual aid while designing. While efforts have been taken to reduce discrepancies between these 
softwares, the programs do not read information the same way. If the file did not originate in Civil 3D there is 
the potential for the display of an object to be different than originally provided. 

Survey Alignments 
Survey alignments may be provided and visible in the native file format, but for the best usefulness as a project 
progresses importing the alignment to Civil 3D from the delivered .xml is suggested.  

To create an alignment from a landxml in Civil 3D, navigate to the “Insert” tab, within the “Import” panel, select 
“LandXML”.  

  

Select the appropriate .xml file that was delivered with the survey alignment data for the project and select 
Open. 
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1. Select all appropriate survey alignments for import. 
2. Under edit import settings verify that Element Constraint Assignment is set to free and floating curve 

groups unless otherwise directed. 

 
3. Select OK to import the alignment(s). 

* The alignment style may need to be adjusted see the Create Alignment Dialog Box section for more 
information on the different alignment styles. 

Once the alignment has been imported a data shortcut can be created so it can be referenced by others 
designers or in other files. 

Survey Surfaces 
Surveyed existing ground surfaces may be provided and visible in the native file format, but for the utmost 
functionality as a project progresses, importing the surface to Civil 3D from the delivered .xml is suggested. For 
existing ground information Civil 3D creates surfaces inside of drawings. These surfaces can then used by 
alignments and corridors to determine elevations at specific locations. 

To create a surface from a landxml in Civil 3D, navigate to the “Insert” tab, within the “Import” panel, select 
“LandXML”.  

  

Select the appropriate .xml file that was delivered with the survey surface data for the project and select Open. 
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1. Select the appropriate surface information for import. 
Definition data provides point and triangle face information 

2. Under Edit import settings verify that the surface import settings are correct. The settings below are 
provided as a suggested starting point. Project specifics may require adjustments. 

 
3. Select OK to import the surface(s). 

Once the surface has been imported a data shortcut can be created so it can be referenced by others 
designers or in other files. 
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Alignments and Profiles 
In Civil 3D, creating alignments and profiles are fundamental steps in the design process. An alignment in Civil 
3D defines the horizontal path for linear features. The primary linear feature being roadway centerline 
geometry, but Civil 3D provides additional categories for offset, curb return, and miscellaneous alignments. 
Alignments can be created from existing lines, polylines, or by using Civil 3D's dedicated layout tools. Once the 
horizontal alignment is established, profiles can then be generated to define the vertical elevation changes 
along that alignment. Surface profiles are extracted from existing ground surfaces to visualize the terrain, while 
layout profiles are designed to represent the proposed finished grade of the project. Both existing and 
proposed profiles can be superimposed within a profile view, offering a comprehensive understanding of the 
vertical design. 

Alignments 
To create an alignment in Civil 3D, navigate to the "Home" tab, within the "Create Design" panel, select 
"Alignment" to open the menu of options for creating an alignment.  

 

When clicked, the drop-down menu will look like this: 

 

There are many options for how to create an alignment. For this manual Alignment Creation Tools and Create 
Alignment from Objects will be highlighted and demonstrated. These two processes will cover most of the 
alignments you may need to create. Each alignment creation method will yield an alignment of equivalent 
downstream usefulness and quality, therefore the preferred approach is ultimately individual user preference. 
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Create Alignment from Objects 
When you use the Create Alignment from Objects tool you can convert existing AutoCAD objects, such as 
lines, arcs, and polylines, into Civil 3D alignment entities. These will either need to be drafted or attached as an 
xref prior to starting the tool. This method may be more useful when creating surveyed alignments if they have 
been provided. For additional instruction on drafting alignments from scratch see Appendix B. 

Select Create Alignment from Objects. 

 

Once selected, you will be prompted at the command line with the following steps: 

1. Select lines/arcs or polylines to create alignment. 

2. Press Enter to accept alignment direction or [Reverse] – This option sets the direction of the 
stationing for the alignment. There will be arrows displayed on the objects showing the direction of stationing if 
you press Enter. If you type R then hit the Enter key, this will reverse the direction of the alignment and 
stationing.  

3. See Create Alignment dialog box below to input the alignment specific parameters. 

4. The alignment will be created in the file once you select OK. 

* If an alignment has been created via objects and a PI is not behaving as expected it may be useful to Solve 
PI. Ensure that under alignment properties on the Point of Intersection tab the selection is set to “By change in 
alignment direction” If that is set you should be able to hover over the implied PI and choose the Solve PI 
option.  
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Alignment Creation Tools 
When you create an alignment using the Alignment Creation Tools you will start the tool first and then draft the 
alignment. This method may be more useful when creating proposed alignments for design. 

Select Alignment Creation Tools. 
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1. See the Create Alignment Dialog Box section to input the alignment specific parameters. 

2. The Alignment Layout Tools will appear once you select OK. 

 

* To access Alignment Layout Tools later for alignment edits, select the alignment to be edited, then in the 
contextual tab modify panel select the Geometry Editor. 

 

3. For a basic roadway centerline alignment select the Tangent-Tangent (With Curves). 

 

4. You will be prompted with Specify start point for the first PI then Specify next point for each 
subsequent PI. The curves will be added based on the default radius provided in the Create Alignment Dialog 
Box. The curve radii and PI’s can be adjusted after the alignment is created to match project constraints. 

5. Press enter to end the command. 

While the Tangent-Tangent (With Curves) tool is a quick way to lay out an alignment with all the entities 
included, individual lines and curves can be drawn as well. These can be drawn in any order and connected 
later to form the alignment. Below are descriptions for some of the more frequently used tools. 

 

1. Tangent-Tangent (No Curves) or Tangent-Tangent (With Curves): Layout an alignment by selecting 
PI points in sequential order. 

2. Insert PI: Add PI to line segment within existing alignment 
3. Delete PI: Remove a PI from an existing alignment 
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4. Line Commands: Any of these commands may be used to create lines for an alignment. The two 
described below are likely to be used the most. 

A. Fixed Line (Two Points): Each end of the line has a defined location. 
B. Fixed Line – Best Fit: The line will be defined by selecting a group of points which control the 

best fit. * After the line is created and added to the alignment it is possible to remove the line’s 
relationship to the points it was created from. 

 
5. Curve Commands: Any of these commands may be used to create curves for an alignment. The three 

described below are likely to be used the most. 
A. Free Curve Fillet (Between two entities, radius): The curve will be tangent to the two selected 

entities with a set radius. 
B. Free Curve Fillet (Between two entities, through point): The curve will be tangent to the two 

selected entities and pass through a specified point. 
C. Free Curve - Best Fit: The curve will be tangent to the two selected entities and the radius 

defined by selecting a group of points to best fit to. * After the curve is created and added to the 
alignment it is possible to remove the curve’s relationship to the points it was created from. 

 
6. Spiral Commands: SCDOT does not use spiral curves for alignments. 
7. Alignment Grid View: Opens the Panorama window and displays the alignment entities in a table 

format such that they can be reviewed and/or edited.  

Fixed vs. Floating vs. Free 
In Civil 3D, alignment entities can be Fixed, Floating, or Free, which determines their Tangency Constraints 
and how they behave when edited. The terminology can be confusing when first getting started.  

• Fixed entities are geometrically defined and are independent of other entities. They have no tangency 
constraints to other entities and they do not maintain tangency if edited.  

• Floating entities are geometrically defined and have a tangency constraint to either the preceding or 
succeeding entity. They will maintain tangency with the entity they are constrained to if edited.  

• Free entities have tangency constraints to both the preceding and succeeding entities, ensuring 
tangency to both and moving to maintain these relationships. 
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A typical alignment would have tangency constraints similar to below 

 
 
* The video link below does a great job of explaining alignment creation and how to use the tools effectively. 
https://youtu.be/I05LCmv2K2Q?t=465 From 7:45 to 32:00 covers the topics discussed here. 

Create Alignment Dialog Box 
In the Create Alignment dialog box, fill out and make the following assignments. 

1. Name: Provide an appropriate alignment name. For centerline alignments the appropriate road name 
and number should usually be used (Ex. US 1 (Two Notch Road) or SC 12 (Forest Drive)). This name 
can be changed later and can also be used with the label tool for automatic labeling. 

2. Type: Choose the appropriate type for the subject alignment, see below for additional guidance 
a. Centerline: This type can be created from existing geometry or by using the layout tools. It is the 

most common type and can have design criteria applied to it, such as design speed and 
superelevation. A centerline alignment can also act as a "parent" to other objects like profiles, 
corridors, offset alignments, curb return alignments, and intersections. 

b. Offset: This type is dynamically linked to a "parent" alignment (of any type). Changes to the 
parent alignment's geometry or stationing automatically update the offset alignment's position. A 
varying offset value can be used by adding widening regions. 

c. Curb Return: This type is designed to connect two intersecting alignments and their 
corresponding profiles. They are typically created automatically using the Intersection Wizard or 
the Connected Alignments tool. 

d. Rail: Specialized for railroad design. (Not used for SCDOT Projects) 
e. Miscellaneous: This type is the simplest and most unmanaged. It does not have design criteria 

properties and is not dynamically linked to other alignments. This offers more editing freedom 
but lacks the automated rules of other types. 

3. Start Station: Enter the start station for your alignment. * This can be edited later. 
General 

4. Site: Leave this as None unless a site has been setup for the project. 
5. Alignment Style: Select the appropriate style. This controls the visual display of an alignment by 

setting layers, colors, line styles and other attributes. 
a. Relocation: Used where an alignment differs from the existing/surveyed centerline. 
b. Surveyed: Displays the existing/surveyed centerline. 
c. Surveyed [Point Markers]: Displays the existing/surveyed centerline and includes PI markers 

6. Alignment Label Set: Choose the appropriate label set. Label sets should be considered as a starting 
point for alignment labeling. Project specific adjustments can be made later in Alignment Label 
Properties 

7. Conversion Options: * These options are only displayed when creating an alignment from objects. 
a. Add curves between tangents: Uncheck this box to retain connected tangents if desired.  
b. Erase existing entities: Uncheck this box to retain the polyline, line, etc. once the alignment 

object is created. 
Design Criteria 

https://youtu.be/I05LCmv2K2Q?t=465


 

49 

8. Starting Design Speed: Set the alignment’s design speed. * The design speed can be split into station 
ranges later in the  Alignment Properties. 

9. Use Criteria Based Design: If this is left unchecked the alignment will not be compared against any 
design criteria. 

10. Use Design Criteria File: Filepath below, adjust year to match installed Civil 3D version 
a. C:\ProgramData\Autodesk\C3D 2026\enu\Data\Corridor Design Standards\Imperial\_Autodesk 

Civil 3D Imperial (2018) Roadway Design Standards.xml 
11. Use Design Check Set: Leave unchecked, Not used by SCDOT at this time. 

   
 Select OK to proceed. 

Add Station Equation 
If a station equation is needed within an alignment follow the steps below to add it. Once the station equation 
has been added to the alignment see How To Add Station Equation Labels to adjust the plan labels for proper 
display. 
 
Left click on an alignment to select it. 
From the contextual tab select Alignment Properties 
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1. Select the Station Control tab 
2. Select “Add station equation” 

 
3. Select ok when warning appears if you are sure you want to make this change. 

 
4. EDITALIGNMENTPROPERTIES Specify station along baseline: 

 
* Either type the station into the command line without the + sign or select a location on the screen. 

5. “Raw Station Back” and “Station Ahead” can be edited to the correct stations as needed. 
6. Increase/Decrease should be left as increasing. This specifies whether the ahead stationing increases 

or decreases. 
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Select OK, there may be an additional warning. 
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Profiles 
To create a profile in Civil 3D, navigate to the "Home" tab, within the "Create Design" panel, select "Profile" to 
open the menu of options for creating a profile.  

 

When clicked, the drop-down menu will look like this: 

  

There are multiple options for how to create a profile. For this manual Create Surface Profile and Profile 
Creation Tools will be highlighted and demonstrated. These two processes will cover most of the profiles you 
may need to create. Create Surface Profile is primarily used for the creation of existing ground profiles and 
Profile Creation Tools is primarily used for the creation of proposed profiles. The Create Profile View 
functionality will also be covered in this section, as it is the method for viewing any profiles that have been 
created and is a prerequisite for the Profile Creation Tools. 

Create Surface Profile 
The Create Surface Profile tool creates a two-dimensional representation of a chosen surface (usually existing 
ground surface) along a horizontal alignment. To use it, there will need to be an available surface and 
horizontal alignment. 

Select Create Surface Profile. 
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This will create a popup box.  

1. Select the desired alignment. 

2. Select the desired surface. 

3. Select the appropriate station range. 

4. Add to the profile list. 

*A. Profiles can also be created that are at an offset from the alignment. 

*B. If the update mode is set to static the profile will not update if the surface is later changed. 

5. When you have finished editing the selections, at the bottom of the screen select OK. 

* Alternatively, you can select “Draw in Profile View” and you will be presented with the “Create Profile View” 
dialog discussed in the next section. 
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Create Profile View 
A profile view is required to visualize the existing ground surface along a selected alignment. The view's 
appearance-including linestyles, labels, and grid layout-is governed by user-selected display styles. The 
existing ground profile view will provide the baseline data needed for the subsequent creation and design of 
the proposed profile.  

* Profile views may need to be created at various stages or for specific use cases throughout a project 
lifecycle. For example, it may be useful to create a full-length profile view with wide margins to use for design 
and then create multiple smaller profile views with specific size grids to use for plan sheets. Some of the 
selections discussed below may be less important for a design profile vs. a plan sheet profile and vice versa. 

Select Create Profile View under the “Home” tab “Profile & Section Views” Panel 

 

This will open a dialogue box titled “Create Profile View”. On the left side are a list of different categories within 
the dialog that can be edited to meet specific needs. The categories can be navigated either by using the 
Back/Next buttons at the bottom of the menu to explore in order or by selecting a specific category on the left-
hand side. 

General- Specify the Alignment, Profile view name, Description, and Profile view style. 
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*The “Show offset profiles by vertically stacking profile views” is optional. 

Station Range- Specify the start and end stations either by allowing the program to select automatically or by 
selecting specific start and end stations. 

 

Profile View Height- Specify the profile view height either by allowing the program to select automatically or by 
selecting specific minimum and maximum elevations. 

* The “Split profile view” is optional and may be useful if a profile has a sharp peak or valley that would not fit 
within the normal vertical bounds. The split may need to be modified in the Profile View properties after the 
profile view creation if the program makes poor automatic selections. 
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Profile Display Options- Specify the profiles to be drawn as well as many other optional adjustments. Some 
columns are provided as information while others allow edits. 

 

Name – (Information) Any profile associated with the selected alignment will be displayed here. 

Draw – (Edit) If selected the profile will be drawn. 

Clip Grid – (Edit) Specifies which profile controls where the grid is clipped. 

Split At – (Edit) Specifies which profile controls where splits are made. 

Description – (Edit) * Provide description if desired. 

Type – (Information) Surface profile, Layout Profile, Corridor Profile, or Superimposed Profile 

 * In Civil 3D the term Layout Profile is what you may typically refer to as Proposed Profile, PGL, etc. 

Data Source – (Information) Specific data source for Surface, Corridor, and Superimposed profiles. 

Offset – (Information) Offset from alignment or offset from source alignment for a superimposed profile. 

Update Mode – (Edit) If set to dynamic and source changes the profile will reflect the change. 
   If set to static and the source changes the profile will not reflect the change. 

Layer – (Edit) A specific layer can be specified * This should be left blank for normal use. 

Style – (Edit) Select the appropriate style to be applied globally when this profile is in a profile view. 

Override Style – (Edit) * Display a different style in one profile view without altering the global style settings. 

Labels – (Edit) Select the appropriate label style to be applied. 

Alignment – (Information) Alignment that the profile is following. 

Station – (Information) Start and End stations for the profile. 

Elevation – (Information) Minimum and maximum elevations for the profile. 

 

Pipe/Pressure Network- Entire pipe networks or specific parts of a network can be displayed on profile views.  
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1. By default if the entire network is selected all the network parts will be displayed along the profile.  

2. Specific objects can be selected as well by using “Select parts from screen”. 

A. [pipe Network] (default) If a network part is selected the entire network is added to the selection. 
CREATEPROFILEVIEW Select pipe network 

B. [individual Parts] Each network part will need to be selected individually.  
CREATEPROFILEVIEW Select pipe network part 

C. [Series of parts] If two network parts are selected every part in between will also be selected. 
CREATEPROFILEVIEW Select first network part 
CREATEPROFILEVIEW Select next network part 

3. If only certain objects are selected within a network the selection box will display as solid. 

Data Bands- Select an appropriate data band set and adjust the properties if needed. 

 

Profile Hatch Options- Specifies how to mark areas between two profiles on the profile view, such as where 
terrain must be cut or filled to create the design profile. SCDOT does not use this function currently. 

Once each of the categories have been filled out, click “Create Profile View”.  

CREATEPROFILEVIEW Select profile view origin:  

In model space click a location for the lower left corner (origin) of the profile view grid. The profile view will be 
drawn. Most of the selections made through the profile view creation process can be edited later by opening 
the profile view properties. Select the profile view then from within the contextual tab select “Profile View 
Properties” 
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Profile Creation Tools 
The profile creation tools allow the user to draft layout profiles along selected alignments and make edits to 
those profiles later as needed. Profile creation tools operate in a similar fashion to how the previously 
discussed alignment creation tools operate. To use this function there will need to be a profile view available 
and, in most cases, an appropriate surface profile that is already displayed in the profile view.  

Select: Profile Creation Tools 

 
 
CREATEPROFILELAYOUT Select profile view to create profile: 

Select the appropriate profile view where the layout profile is to be drafted. 

* Since profile views are tied to a specific alignment, if there are multiple profile views displaying that 
alignment, any new layout profiles added to one profile view will be added to others as well. As covered 
previously the display of each profile can be toggled in the profile view properties but each new profile will 
default to being displayed. 

1. See the Create Profile Dialog Box section to input the profile specific parameters. 

2. The Profile Layout Tools will appear once you select OK. 

 

* To access Profile Layout Tools later for profile edits, select the profile to be edited, then in the contextual tab 
modify Profile panel select the Geometry Editor. 
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3. For a basic roadway profile select the Draw Tangents With Curves. 

 

4. You will be prompted with Specify start point for the first PVI then Specify end point for each 
subsequent PVI. The curves will be added based on the default K-value or length provided in the Create Profile 
Dialog Box The curve parameters and PVI’s can be adjusted after the profile is created to match project 
constraints. 

5. Press enter to end the command. 

While the Draw Tangents With Curves tool is a quick way to lay out a profile with all the entities included, 
individual tangents and curves can be drawn as well. These can be drawn in any order and connected later to 
form the alignment. Below are descriptions for some of the more frequently used tools. 

 

1. Draw Tangents or Draw Tangents With Curves: Layout a profile by selecting PVI points in sequential 
order. 

2. Insert PVI: Add PVI to tangent segment within existing profile. 
3. Delete PVI: Remove a PVI from an existing profile. 
4. Move PVI: Select a PVI and move it to a specified location. 
5. Tangent Commands: Any of these commands may be used to create tangents for a profile. The three 

described below are likely to be used the most. 
A. Fixed Tangent (Two Points): Each end of the tangent has a defined location. 
B. Fixed Tangent – Best Fit: The tangent will be defined by selecting a group of points which 

control the best fit. If COGO points are chosen the points will be selected from the model space 
within the plan view objects and will need to have the appropriate elevations assigned * After 
the tangent is created and added to the profile it is not possible to fully remove the tangent’s 
relationship to the points it was created from. To remove this relationship, delete the entities and 
recreate via other methods. 

C. Solve Tangent Intersection: If during the profile creation process there are two adjacent 
tangents created that are not connected at the PVI this tool can be used to connect the tangents 
at the correct location. 
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6. Curve Commands: Most of these commands may be used to create curves for a profile. The three 

described below are likely to be used the most. 
A. Free Vertical Curve (Parabola): Select two adjacent tangents and provide curve parameters. 

The curve will be tangent to the two selected entities with a set length or K value. 
B. Free Vertical Parabola (PVI based): Select a PVI and provide curve parameters. The curve will 

be tangent to the two selected entities with a set length or K value. 
C. Free Vertical Curve - Best Fit: The curve will be tangent to the two selected entities and the 

length and K value defined by selecting a group of points to best fit to. If COGO points are 
chosen the points will be selected from the model space within the plan view objects and will 
need to have the appropriate elevations assigned * After the tangent is created and added to 
the profile it is not possible to fully remove the tangent’s relationship to the points it was created 
from. To remove this relationship, delete the entities and recreate via other methods. 

D. SCDOT does not use circular vertical curves. 

 
7. Insert PVIs – Tabular: PVIs can be manually inserted by providing stations, elevations and curve 

parameters. * Press enter after filling in the last column’s data to create an additional row. 
8. Raise/Lower PVIs: Quickly adjust profile vertically while holding grades and curve parameters. Limits 

can be set by station or to the full length of the profile. 
9. Copy Profile Data: This tool can be used to rapidly copy a specific station range or full length of a 

profile. When toggled to “Create new profile” the new profile will be superimposed on the original one in 
the current profile view and will appear in the Toolspace Prospector tab under the parent alignment. If 
using for alternative analysis and an alternative profile materializes to replace the current profile, this 
tool can be used as well. To replace the current profile with an alternative, select this tool and choose 
the "Overwrite existing profile" option. * This could be helpful for preliminary design, ditch profiles, curb 
grades, and when alternatives/revisions are needed. 
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10. Delete Entity: Used to delete entities one at a time from the profile. A tangent entity that has a curve 
attached to it cannot be deleted, any dependent curves must be deleted first. 

11. Edit best fit data for all entities: Only available if there are best fit elements within the profile. When 
selected the Regression Data tab will be opened in the Panorama window for editing chosen points. 

12. Profile Grid View: Opens the Profile Entities tab in the Panorama window to be used for tabular editing 
of the profile. 

13. Displays entity based data in grid and layout parameter editors: Toggles the Profile Entities tab in 
the Panorama window between displaying the data either ordered by PVIs or ordered by entities. 

* See Fixed vs. Floating vs. Free in the alignments section for clarity on how constraints are applied if needed. 
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Create Profile Dialog Box 
In the Create Profile dialog box, fill out and make the following assignments. 

1. Alignment: The alignment will have usually been selected. If not select from the list of available 
alignments. 

2. Name: Provide an appropriate profile name. For centerline profiles the appropriate road name and 
number should usually be used (Ex. US 1 (Two Notch Road) or SC 12 (Forest Drive)). In addition it is 
helpful to add either existing/surface or proposed/layout to the name. This name can be changed later 
and can also be used with the label tool for automatic labeling.  
General 

3. Profile Style: Select the appropriate style. This controls the visual display of a profile by setting layers, 
colors, line styles and other attributes. 

4. Profile label set: Choose the appropriate label set. Label sets should be considered as a starting point 
for profile labeling. Project specific adjustments can be made later in Profile Label Properties 
Design Criteria 

5. Use Criteria Based Design: If this is left unchecked the profile will not be compared against any 
design criteria. 

6. Use Design Criteria File: Filepath below, adjust year to match installed Civil 3D version 
a. C:\ProgramData\Autodesk\C3D 2026\enu\Data\Corridor Design Standards\Imperial\_Autodesk 

Civil 3D Imperial (2018) Roadway Design Standards.xml 
7. Use Design Check Set: SCDOT 
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Superelevation 
Superelevation in Civil 3D is attached to the alignment object, therefore the steps below need to be completed 
in the file that holds the alignment object, not a file where the alignment is referenced as a data shortcut 

Calculate/Edit Superelevation 
Select the alignment object that the superelevation is to be applied to, then on the contextual tab and “Modify 
Panel” select “Superelevation” then select “Calculate/Edit Superelevation”. 

 

Choose “Calculate superelevation now”.  
* This will only appear if superelevation has not been applied to the alignment previously. 
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Roadway Type: Undefined Crowned about the Center Baseline should cover most project scenarios. If another 
type or method is needed for a project Autodesk has documentation on all the different combinations that may 
be used.  
About Superelevation on Undivided Roads   About Superelevation on Divided Roads 

 

Lanes: The information supplied here influences the calculations for transition lengths etc. Input project specific 
cross section information to match the roadway typical section. 

https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-2F87B573-CC28-4F8A-B4F2-F32367E7D648
https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-19603039-2520-4BBD-ADD8-21912E660761
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Shoulder Control: The information supplied here influences how shoulder cross slopes are calculated. Input 
project specific shoulder information to match the roadway typical section. See RDM Section 5.3.5 for 
additional information. Inside median shoulders will only be available for edit if the roadway type is divided. 
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Attainment: The information supplied here selects the superelevation rate and adjusts the transition length 
calculations. 

1.  Verify the design criteria file matches the project design standard.

 
2. Select the design superelevation rate. 
3. Select the appropriate transition length table if available. 

* There are only two transition length tables available (two lane and four lane). If your roadway falls 
outside of these options the transition lengths will need to be manually edited after they are created. 

4. Input the percent of superelevation runoff length to be placed on the tangent. 
5. Spiral curves not used on SCDOT projects. 
6. Add a length for apply curve smoothing as appropriate. See RDM section 5.3.4.2 Item #2 for additional 

information. 
7. Civil 3D can make corrections if adjacent curve transition lengths overlap. Whether this option is used 

or not, it is suggested that the designer review any areas where overlaps may occur to ensure 
compliance with the RDM. 

8. Select finish. 
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View Tabular Editor 
The Superelevation Tabular Editor will pop up in the Panorama window after finish is selected. This both 
provides a summary of the superelevation calculations and the opportunity to make edits.  

1. Lines can be manually added or subtracted for locations where the superelevation makes a transition. 
2. The shoulder transitions do not automatically calculate to match the RDM. These can be manually 

adjusted to transition at the correct locations here. 
3. Some items are duplicates and are displayed in multiple locations. 
4. All of the values in the columns can be edited as needed. 
5. Take note of the superelevation lanes listed at the top. These will need to match the superelevation 

input selected when applying superelevation to a Subassembly. 



 

68 

 

Assemblies and Subassemblies 
Assemblies and subassemblies are used together to form the core of a 3D corridor model. Subassemblies are 
the individual parts, such as lanes, curbs, sidewalks, and slopes, that connect to create the complete 
assembly. Assemblies are applied to an alignment and profile over specific station intervals to generate a 3D 
corridor model, representing the design of a roadway. The assemblies and subassemblies discussed below 
are provided with the SCDOT state kit. These subassemblies are designed to manage a majority of typical 
scenarios for road design and include built in functionality to streamline downstream uses of the corridor 
(surface creation, quantity takeoff, etc.) If additional functionality is needed for a project, there are 
subassemblies available from Autodesk within the Tool Palettes, or the Autodesk Subassembly Composer can 
be used to develop new subassemblies. 

Assemblies 
In Civil 3D, an assembly is a collection of subassemblies that when used together define a typical cross-
section for a corridor. Under the assembly properties, the separate subassemblies can share information and 
link together to create more dynamic and flexible assemblies. 

Create an Assembly 

To create a new assembly in Civil 3D, navigate to the "Home" tab, within the "Create Design" panel, select 
"Assembly" then “Create Assembly”. 
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Create Assembly Dialog Box 
In the Create Assembly dialog box, fill out and make the following assignments. 

1.  Name: Provide an appropriate assembly name. Road name and station range may be appropriate 
items to include in the name. This name can be changed later if needed. 

2. Assembly Type: Choose the appropriate type for the subject assembly. In most cases “Undivided 
Crowned” or “Other” can be selected here. see the Superelevation section for additional guidance if 
another type was used when calculating superelevation. 

3. Assembly style: Select the appropriate Assembly style. 
4. Code set style: The Corridor Code set style has been created to display assemblies according to 

SCDOT codes. See code set styles for more information.  
5. Select OK to create the assembly then follow the command line prompt. 

CREATEASSEMBLY Specify assembly baseline location: 

6. The assembly baseline has been created. Follow the subassemblies section to build out the desired 
assembly section. 

   

Subassemblies 
Subassemblies are the fundamental geometric building blocks used to define a road's cross-section within an 
Assembly. Subassembly input parameters and targets allow them to adapt to complex and dynamic design 
scenarios. Input parameters control the geometry and behavior of components, allowing flexibility by replacing 
hardcoded values for dynamic adjustments to corridor models. Subassembly targets allow pre-defined points 
(existing pavement edges, lane edges, face of curbs, etc) to automatically connect or adjust to other design 
elements (the target) like alignments, profiles, surfaces, 3D polylines, or feature lines, ensuring the corridor 
geometry adapts to site conditions and changes without manual editing of the subassembly, easily controlling 
widths, elevations, and slopes for realistic road design. 
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Subassemblies are accessed through the “Tool Palettes”. There are multiple ways to access the “Tool 
Palettes”. 

1. On the “Home” tab under “Palettes” select “Tool Palettes” 

 
2. Select the assembly that was just created. In the contextual tab in the “Launch Pad” panel select the 

“Tool Palettes” 

 
3. Press “Ctrl” + “3” on the keyboard 

 
Once the “Tool Palettes” is open it should default to the SCDOT Subassemblies tab.  

1. If the “SCDOT Subassemblies” tab is not displayed or if you would like to access some of the default 
Autodesk Civil 3D Subassemblies right-click on “Tool Palettes” and a list of available palette groups 
should be available. 

 
2. If you are in a palette group and are looking for a specific tab that is not displayed, left-click on the three 

lines at the bottom to open the full list of available tabs within that palette group. 
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Subassembly Placement 
To place a subassembly there must first be an assembly baseline created. See the previous section for 
assemblies if this has not been created yet. It is also suggested to have the properties palette open for the 
ability to make edits to the subassemblies as they are inserted. 

On the “Home” tab under “Palettes” select “Properties” to open the properties palette. 

 
1. In the Tool Palette select the first subassembly to be inserted. 
2. Review the Advanced Parameters in the Properties Palette to verify the subassembly matches the 

desired parameters. These can be edited after the subassembly is placed if there are design changes. 
* If additional information is needed to understand how a parameter functions, hover over the 
parameter and a description will be displayed. 
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The layout under Advanced Parameters is split into four distinct sections.  

 
1. Output: Each subassembly may have read only output parameters that can be passed to other 

subassemblies as input parameters to help connect the total assembly together. This is discussed 
further in the Connect Subassembly Parameters section of this manual. 

2. Geometry: These are the parameters that change the actual geometry of the subassembly to 
control widths, slopes, depths, etc. 
* Civil 3D by default displays the Drawing Unit symbol(‘) behind these parameters. If the 
parameter’s unit differs from feet it will be listed in the parameter name for clarification and the (‘) 
can be ignored. 

  

* Civil 3D will accept input as inches and convert to the appropriate length in feet if the (“) symbol is 
added to a value. 
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 adjusts to  

3. Codes: These parameters set standardized point, link and shape code names for the parts of a 
subassembly that can be used to control the display of a corridor, manage how labels are 
displayed, generate surfaces, develop quantity takeoffs. 

4. Optional Codes: Additional codes can be added by the user to facilitate project specific modeling 
tasks. 

3. Follow the prompt in the command line. 
CREATESUBASSEMBLYTOOL Select marker point within assembly or [Insert Replace Detached]: 

 
The subassembly will be placed appropriately. 

 

Other options 
a. Insert – A Subassembly can be placed between two existing subassemblies. 
b. Replace – A Subassembly can be swapped into the same location as a current Subassembly. 
c. Detached – A Subassembly can be placed unattached to an Assembly. 

4. To add additional subassemblies repeat steps 1-3. 

* Depending on which Code Set Style the Assembly is set to, the additional marker points may or may 
not be displayed. They will be present and function even if they are not visible.  

   
Visible      Not Visible 

 

Connect Subassembly Parameters 
Once subassemblies have been compiled into an assembly, outputs and inputs can be linked between 
subassemblies to carry information throughout the entire assembly. Some of the subassemblies have been 
built to reference information from an adjacent subassembly (ex. Vertical face curb references adjacent 
travelway slope to switch between catch and spill curb in appropriate areas) 

Select the Assembly baseline 
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In the Contextual tab under the “Modify Assembly” panel select the “Assembly Properties” 

 

Inside the Assembly Properties Dialog select the Construction tab.  

 

Overview of Construction tab 

1. Item: The left and right side of the subassembly are separated out and distinct from each other. 
Subassembly Input values cannot cross over the baseline.  
* Rename the subassemblies here with descriptive names to help differentiate them later. 

2. Input Values (Default): All the default input values for each of the subassemblies (seen under 
advanced parameters when initially placing a subassembly) are available for manual editing here.  

3. Input Values (Parameter Reference): A parameter reference in an assembly is a dynamic link that 
allows one subassembly's input parameter to automatically adopt the value of another 
subassembly's output parameter within the same assembly 
* The first subassembly attached to the baseline on either side cannot have a parameter reference 
because there are no prior subassemblies to pass down output variables. 
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Example: Adjusting Input Parameters and parameter References 
The assembly section below will be edited on the right side to demonstrate how adjusting inputs and parameter 
references interact within an assembly. This assembly is built with two travelway subassemblies and a curb 
subassembly on each side. 

 

Edit Travelway Inside Right input values as shown below. 
* For this example the Travelway Slope was set to 3% so the assembly display would adjust. For a project, 
unless the intent is to have a constant slope, the Superelevation Lane needs to be selected so the cross slope 
will follow the superelevation calculations. 
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Edit Travelway Outside Right parameter references as shown below. 
* Special note on superelevation: If the superelevation lane is selected on the first subassembly and the 
second needs to match, set the Travelway Slope input to match rather than the Superelevation input. Notice 
that the default input values do not change. Setting the parameter reference overrides the defaults to match 
the linked subassembly.  

 

Edit VFCurbGutter Right parameter references as shown below. 
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* Some parameters have “[Inherited]” included as part of the name. These parameters will need to be linked for 
the subassembly to function correctly. When selecting the parameter reference all available outputs will be 
displayed, this is where providing descriptive names for the subassemblies helps clearly define which output to 
select.  

 

         

Assembly section after edits have been made. 

1. Slope and pavement depths adjusted based on default input value modifications. 
2. Slope and pavement depths adjusted to match adjacent based on parameter reference selections. 
3. Curb and Gutter switched to spill curb based on slope selected by parameter reference. 
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Corridors 
Corridors are dynamic 3D models built from the alignment, profile, superelevation, assembly and subassembly 
objects covered so far. The corridor can then be used for surface creation, quantity takeoff, dynamic cross 
section creation, and detailed visualization once it is built. The corridor should be created in it’s own file and 
use Data Shortcuts to reference in other design information such as Alignments, Profiles, Surfaces. 
 

Create a Corridor 
To create a corridor in Civil 3D, navigate to the "Home" tab, within the "Create Design" panel, select "Corridor" 
to open the menu of options then select “Corridor” again to open the create corridor dialog box.  

 
 
In the Create Corridor dialog 

1. Provide a descriptive name for the corridor. 
2. Select the alignment, profile, and assembly that are to be connected. If the corridor will have multiple 

assemblies along an alignment and profile those can be added in the next step or later under the 
Parameters tab of the corridor properties. Selections can be made either by using the drop down list of 
objects or by clicking the  icon and then following the command line directions to select an object 
from the drawing. 
* If a new file has been created for the corridor and no information is populating in the drop downs, 
verify that the appropriate alignment and profile data shortcuts have been added to the drawing. 

3. Select the appropriate code set style. 
4. Select the surface that is to be used as a surface target (typically the existing ground survey). 
5. Feature lines should not be used for a roadway centerline geometry, however it is important to note 

here that feature lines can be used as a baseline for an assembly in lieu of an alignment and profile 
combination. This may be useful to model certain linear elements that do not strictly follow a roadway 
centerline. 

6. Select OK 
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The Baseline and Region Parameters dialog should appear and look similar to the below.  

 
This is where additional assemblies can be added as mentioned previously. The options present in this dialog 
will be covered in detail below, for now select OK or Apply. When the dialog below appears, select Rebuild the 
corridor. Select OK again if needed. 
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The corridor should now be built. There may be a long list of errors that populate in the panorama window. This 
can be cleared by selecting the green check in the top right.  

 
These errors will be recalculated and added to the list each time the corridor is rebuilt, potentially creating 
many duplicate errors. In the top left, selecting “Action” > “Clear All Events” will remove all the errors such that 
the next time the corridor is rebuilt only current errors will be present.  

 

Corridor Properties 
The Corridor Properties menu in Civil 3D is a central location for managing all aspects of a corridor model. It is 
organized into the following tabs: Information, Parameters, Codes, Feature Lines, Surfaces, Boundaries, and 
Slope Markings. Within this menu it is possible to view and modify general settings, define regions with 
different assemblies, set targets (such as surfaces or feature lines), manage code sets for display, create 
corridor surfaces, add boundaries, and apply slope patterns, providing comprehensive control over the corridor 
design. 

To access the corridor properties select the corridor. Then through the contextual tab on the Modify Corridor 
Panel select Corridor Properties. 
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Information 
Autodesk Information Tab 
On this tab there is the option to change the name, provide a description and select the object style of the 
corridor. The object style controls the display of the corridor information that is shown at elevation zero.  

Parameters 
Autodesk Parameters Tab 
This tab controls the core geometry and layout of the corridor model with the ability to view and edit baselines, 
regions, frequencies, targets, and overrides. This graphic demonstrates the topics that will be covered on the 
following pages. 

 

1. Baselines: A baseline is composed of either an alignment & profile combination or a feature line and is 
proceeded by the text “BL”. Selecting add baseline will open a dialog similar to when first creating a 
corridor, see the Create Corridor section for additional information. 

2. Regions: A baseline can be split into multiple regions which are denoted by the text “RG”. Regions are 
identified by selecting an assembly and providing start and end stations for that assembly. Splitting into 
regions opens the opportunity to incorporate multiple assemblies for different typical sections or have 
gaps in the corridor (ex. Bridges). Regions can be modified by right-clicking on an existing region name. 
The options below will be available. 

 
3. Frequencies: Frequencies define how often a section perpendicular to the baseline will be computed 

within a corridor. Frequency intervals can be set based on location within a curve or tangent, and they 
can be set at the region, baseline or corridor level.  

https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-173B0ED9-0CBA-4A53-BA70-1F6008A2E00E
https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-2FE5FB9F-AF80-4E10-89F4-A809C1D873E8
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Increments along a curve can be defined by a length increment, the mid ordinate distance (maximum 
perpendicular distance from the midpoint of a chord to the actual arc), or both. 

 
Additional stations can be added as well if there is a need for a section at a location that does not fall at 
a regular interval. 

 
After selecting the  follow the command line prompts to select a station. 

EDITCORRIDORPROPERTIES Specify station along baseline: 

* Sections computed according to the frequency settings provided here do not govern where cross 
sections for plan production are placed. Sample lines and section views determine station locations for 
plan production cross sections. With that in mind, if a sample line is defined at a station where a section 
has not been computed according to the frequency settings, the result will be interpolated between the 
two nearest sections. 

4.  Targets: Targets in Civil 3D are objects (alignments, feature lines, polylines, survey figures, surfaces, 
etc.) that a subassembly can reference to dynamically define the geometry of the corridor rather than 
using fixed dimensions. There are three types of targets available: Offset, Elevation, and Surface. 
Similar to frequencies, targets can be set at the region, baseline or corridor level by accessing the 
target mapping menu. 
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Once in the target mapping menu, any targets available within a subassembly will be displayed. It is 
important to note here that Surface targets are on a different tab than Offset and Elevation targets. 

 
 

Example: Defining Offset Target 
What the corridor ditchline looks like before a target is defined. 



 

84 

 
1. Inside the target mapping menu select the appropriate offset target to map to the feature line based 

on subassembly and stationing. 
2. To select the target object(s) click on the  select from drawing button. Follow the prompts in the 

command line.  

EDITCORRIDORPROPERTIES Select objects: 
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The target mapping menu will update with the object(s) name and show that there are one or more 
objects in use. 

 
Select OK, then Rebuild Corridor to see the updates. 
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Example: Defining Surface Target 
 What the corridor looks like with the assembly attached and no surface target.

 

In the target mapping menu on the surface tab select the appropriate surface target from the drop down 
to map to the existing surface for the project. 

 

 

 The target will update to the selection. 

 

 Select OK, then Rebuild Corridor to see the updates. 

 

5. Overrrides: Overrides adjust subassembly input parameters at specific stations or station ranges. In this 
menu they can be viewed and deleted only. Overrides can be applied through the Corridor Section 
Editor.  
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* Overrides should primarily be used for minor edits, while they can be applied over a station range, the 
values are locked to the specific frequency stations present at that time. If the frequency is later 
changed additional stations will not have the override value attached. 

 

Codes 
Autodesk Codes Tab 
This tab controls the display styles of the corridor based on the codes provided with the subassembly. Select 
the appropriate code set style at the top. See code set styles if edits need to be made. 

 

Feature Lines 
Autodesk Feature Lines Tab 
This tab controls whether feature lines are created from subassembly point codes. The default feature line 
styles are setup in the code set styles, but they can be adjusted here if needed. If the check box for connect is 
selected the feature lines will be drawn, if left blank no feature line will be drawn for that code. 

https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-55870521-2E13-4FC5-A5BF-42AA031F80BB
https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-2CFA36A8-16A2-4FE4-961E-BC944664D6B3
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Surfaces 
Autodesk Surfaces Tab 
This tab controls the creation of surfaces from corridor objects. The surface can be created from any point or 
link codes that were specified when the subassembly code parameters were set. 

 

https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-3FD85EB7-4903-4832-BDFD-13F95EE19E5F
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1. Select “Create a Corridor Surface” 
2. Select the appropriate data type “Links” or “Feature Lines” 
3. Select a code to be added as part of the surface. 
* Only feature lines selected as connect on the previous tab are available here for inclusion in a surface. 
4. Click the add button to add a single code to a surface. Multiple codes can be added as needed. 
5. Provide a descriptive name for the surface 
6. Select a surface style that is appropriate for the surface created. 
7. See this link to the Autodesk help website for a description of Overhang Correction and whether it may 

be needed.  
8. Select OK and rebuild the corridor to see the surface created. 

  

https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-49E7C910-1FB7-41C8-9FCD-BDF8A43A78FE


 

91 

Boundaries 
Autodesk Boundaries Tab 
This tab is an extension of the last tab as it allows an option to add a boundary to the surfaces previously 
created. 

Right click on a surface for the different boundary options. “Corridor extents as outer boundary” is a quick way 
to control the surface especially for a Final Top Surface but may not be appropriate for every situation. 

 

 * Typical boundaries created through the surface definitions can still be used as well if that is easier. 

Slope Patterns 
Autodesk Slope Patterns Tab 
Slope patterns can be added between two feature lines to add visual displays for slopes. See the link to the 
Autodesk website if this is desired. 
 

 
  

https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-D75FEEB3-7C00-4B7F-9A11-DE4D016A749E
https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-4C7F7527-9A2E-4F86-9525-89F25338C8B9
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Edit Corridor Transition 
Within a corridor, subassembly parameters can be adjusted to create transitions (ex: lane width, side slopes, 
shoulder widths, etc.). Additionally these transitions can be exported and imported which allows the opportunity 
to rebuild a corridor quickly for situations such as having multiple project alternatives or a file become corrupt. 

To create corridor transitions in Civil 3D, select the corridor, then on the contextual tab, within the "Modify 
Corridor" panel, select "Edit Corridor Transition" to open the corridor transition menu in the Panorama window.  

 

1. Select the appropriate corridor. 
2. Select the appropriate baseline. 
3. Click on “Create a new transition set”. 

 

Follow the prompts in the command line to select the appropriate subassembly. 

Select a subassembly by subassembly name or [Class name]: 

Once a subassembly has been selected a pop up will appear with the available parameters for that 
subassembly. Select the parameter that a transition will be applied to. 

 

Continue to follow the prompts in the command line 

Select the start station of the transition for the WidthTravelway: 
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Enter the parameter value at station 25+75.0000' <12.0000'>: 

Select the end station of the transition for the WidthTravelway: 

Enter the parameter value at station 27+75.0000' <12.0000'>: 

Enter the transition type : [Linear Bay taper Cubic in cUbic out Parabolic in pArabolic 
out Reverse parabolic] <Linear>: 

Select Apply in the Panorama window. The corridor will rebuild and the transition can be seen. 

 

Additional options for editing corridor transitions: 

 

1. Transitions can be added to the same subassembly either above or below the currently selected 
transition.  

2. Deletes the selected line: A single transition or all the transitions for a subassembly can be deleted. 
3. Export Transitions: The corridor transitions can be exported to a .csv file and saved as a backup in 

case they need to be used in the future to recreate a corridor with all the appropriate transitions. 
4. Import Transitions: The corridor transitions can be added to a corridor by import rather than manually 

as well. If there are any existing transitions they will be overwritten (see image below). If there is a case 
where some current transitions need to be maintained and some need to be imported, the best action 
would be to export the current transitions and merge them with the new transitions in excel, then import 
the combined .csv file. 
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Corridor Section Editor 
The corridor section editor is a tool for visually inspecting and manually modifying corridor cross-sections at 
specific stations, allowing the ability to override default subassembly parameters.  

For direction on how to navigate the corridor section editor see the Autodesk link To View Corridor Sections 

To open the corridor section editor in Civil 3D, select the corridor, then on the contextual tab, within the "Modify 
Corridor Sections" panel, select "Section Editor" to open the corridor section editor. 

 

Within the “Corridor Edit Tools” panel select the “Parameter Editor” tool. 

 

Within the Parameter Editor overrides can be added for specific stations or station ranges. 

Use the Station Selection panel to find a station that needs to be edited. 

 

Change any parameters that need to be adjusted at that station or a range of stations. 

https://help.autodesk.com/view/CIV3D/2026/ENU/?guid=GUID-BC4EDB91-ABAA-48B1-99D1-BFBE1BC36958
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To apply a change to a range of stations select Apply to Station Range on the Corridor Edit Tools panel then 
specify the station limits. 

   

Once the parameters have been changed and set to a range if necessary select Update Corridor in the 
Corridor Edit Tools panel to have the corridor reflect the changes. Select close to exit the Corridor Section 
Editor. 
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* Overrides should primarily be used for minor edits, while they can be applied over a station range, the values 
are locked to the specific frequency stations present at that time. If the frequency is later changed additional 
stations will not have the override value attached. In the images below the only change was a decreased 
frequency distance.  

Corridor with lane width and earth shoulder width overrides set and 25’ frequency.
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Corridor with frequency adjusted to 10’. Original overrides hold but do not apply to additional new sections. 
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Plan Production 
Sheet Set Manager 
In Civil 3D the Sheet Set Manager is a powerful tool that organizes, manages, and plots layout tabs from 
multiple drawings as a cohesive project set. It streamlines workflows by enabling automated sheet numbering 
and real-time updating of title block information using fields. Each project should have a sheet set prepared 
that is accessible by everyone working on the project. This creates a centralized location for a set of plans to 
be printed from and provides consistent printing results. 

The sheet set manager can be accessed by: 
Typing the command SSM in the command line. 
OR 
Pressing the keyboard shortcut (Ctrl + 4). 
OR 
To open the Sheet Set Manager in Civil 3D, navigate to the "Home" tab, within the "Palettes" panel, select 
"Sheet Set Manager". 

 

Create New Sheet Set 
In the Sheet Set Manager select New Sheet Set 
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Begin: Select “An example sheet set” then press Next 

 

Sheet Set Example: Select the SCDOT SSM Setup then press Next. 
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Sheet Set Details:  

1. Provide an appropriate name.  
2. Provide a description if desired. 
3. Select the location for the sheet set file (.dst).  

* Notice the note below the file path. A suggestion would be to place this in the same location as the 
Data Shortcuts folder. 
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4. The sheet set properties are where selections can be made that will generate throughout all the sheets 
in a set. 

 
a. Most of the information in the Sheet Set should have been filled out already. 
b. The Project Control can be left blank. 
c. The Sheet Creation information should populate but can be reviewed or changed here. 
d. The Sheet Set Custom Properties is where project specific information can be input that will be 

present on all the sheets.  
e. Additional Custom Properties can be added for project specific use if needed. 

Confirm: The confirm page allows for review of all the selections made. Select Finish to create the sheet set. 

The sheet set will be created with default subsets following the standard SCDOT sheet numbering scheme. 
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01 Title Sheets 
If a sheet set has not been created yet see the Create New Sheet Set section above.  

Start by opening the appropriate project sheet set. Then right click on the Title Sheets subset and choose  
New Sheet… 

 
 
In the new sheet dialog: 

 
1. Add a Sheet Number 
2. Add a Sheet Title 
3. The filename will default to a combination of the sheet number and filename but can be edited. 
4. The folder path will default to the location setup when the sheet set was created but can be edited. 
5. The sheet template should be maintained to setup a Title Sheet. 
6. If this is checked the sheet will open automatically in Civil 3D to allow edits. 

The sheet will be created as a layout in a new file in the folder specified in item 4 above. 
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* Notice that the text fields in gray match the information that was provided in the custom properties when the 
sheet set was created. 

If any custom properties need to be adjusted for a project, right-click on the sheet set name in the sheet set 
manager then select properties. 

 

Any of the custom properties can be edited. 

 

Type RE for Regen into the command line and the text field will be updated on the sheet. 

 

Some blocks have been created to provide consistency while filling out the title sheet. By left-clicking the X 
symbols of the “Environmental Permit Information Section” and left-clicking the blue downwards facing arrow, 
you can toggle whether the X’s should be “Visible” or “Invisible” for the road plans. 
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Similarly, by left-clicking the circle in “Railroad Involvement Section” and left-clicking the blue downwards 
facing arrow, you can toggle whether “YES” or “NO” will be circled. 

  
 
Fill out and edit any normal text objects as needed to match project information. 
 

Title Sheet Location Map 
Current SCDOT county maps can be accessed on the SCDOT website at 
https://info2.scdot.org/GISMapping/Pages/OrderMaps.aspx or by searching “Maps” at scdot.org 
 
On the county maps page select the appropriate county map for the project. 

https://info2.scdot.org/GISMapping/Pages/OrderMaps.aspx
https://www.scdot.org/


 

105 

 
Once the county map is downloaded save it to an accessible location for the project. 
* The same folder as the sheet set would be suggested.  

Switch to the model space    

 
 
The .pdf of the county map will need to be attached as an External Reference  
 

 
 
The default values can be used for the location of the map. Select OK to attach the map as an external 
reference 
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* If it is desired to have the title sheet map to scale, a scale could be set here or the scale of the external 
reference could be manually adjusted once it is placed to adjust the map size to a 1 to 1 scale. 

Double center-click on the screen to perform a zoom extents, the drawing view will adjust so that all objects in 
the drawing are visible on screen. Use this to help verify that the map was attached as intended. 
 
Return to the title sheet layout tab. 

 
Click on PAPER in the status bar to toggle from Paper space to Model space. 

 
Once in Model space the status bar will say MODEL and the viewport in the center of the sheet will be 
highlighted and activated in model space. 
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In the status bar verify that the viewport is unlocked. 

 
Then double center-click within the viewport to use the zoom extents again and zoom to the map. 

 
Zoom in and out or pan around to find the project location on the map.  
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Once the map extents are at the desired location lock the viewport in the status bar to prevent inadvertent 
changes. 

 
Click on MODEL in the status bar to toggle from Model space to Paper space. 

 
 
* If the map was scaled appropriately in model space type RE for regen in the command line and the scale 
should update to be correct. If not, the scale text will need to be adjusted to reflect that the map is not to scale. 

   OR    
 
Under the “Annotate” tab in the “Leaders” panel use the “Multileader” tool to add the appropriate project notes. 
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02 Summary of Estimated Quantities Sheets 
Coming soon 

03 Typical Section Sheets 
Coming soon 

04 Right of Way Data Sheets 
Coming soon 

05 General Construction Notes Sheets and Reference Data Sheets 
Coming soon 

06 Plan and Profile Sheets etc. 
Coming soon 

Labeling Alignments 
Coming soon 

Labeling Profiles 
Coming soon 

Create Sample Lines 
Coming soon 

Create Sections 
Coming soon 

Create Cross Section Sheets 
Coming soon 

Plotting  
Coming soon 
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Deliverables 
eTransmit 
Coming soon 
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Other 
Dynamo Tools 
Dynamo is a visual programming application integrated into Civil 3D that enables the automation of repetitive 
tasks. A select group of tools have been built and included in the state kit. These tools can be accessed and 
run by using the Dynamo player. 

Dynamo Player Setup 
To open the Dynamo Player in Civil 3D, navigate to the "Manage" tab, within the "Visual Programming" panel, 
select "Dynamo Player". 

 

The player will open and the default folder will be set to Autodesk Samples 

 

Select the Add Folder icon to add an additional folder location that houses dynamo files. 
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Select the “+” icon to add a new folder 

Navigate to and select the folder below 

C:\Stnd\C3D\Program\Dynamo 

 

Select “OK” 
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The Dynamo folder is now available for selection. 

Construction Limits 
The Construction Limits dynamo adds cut and fill distance text labels at specified intervals along a corridor. 

In the Dynamo player select the Construction Limits dynamo script. 
* Follow the Dynamo Player Setup instructions if Construction Limits is not available. 

 

Fill out the five input items for this dynamo script. 

1. Select the appropriate layer from the dropdown list of layers present in the drawing. 
2. Select the Drawing annotation scale that the construction limits need to be placed at. 
3. Select the frequency that the labels will be placed at along curves. 
4. Select the frequency that the labels will be placed at along tangents. 

* The corridor frequency must also fall at the specified intervals. (ie if the corridor has a 100’ frequency 
throughout 50’ frequencies set here will only produce labels at the corridors 100’ locations.) 

5. Select the corridor object from the drawing. 
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6. Select Run and the dynamo script will process and draw the construction limit labels. 
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Intersection Sight Distance 
The Intersection Sight Distance Case B dynamo plots a 2D ISD triangle for both left and right turns using 
passenger car, single-unit truck, and tractor/semitrailer design vehicles. It will also draft a 3D sight line and 
check whether a selected surface intersects that line indicating a sight obstruction. 

In the Dynamo player select the Intersection Sight Distance Case B dynamo script. 
* Follow the Dynamo Player Setup instructions if Intersection Sight Distance Case B is not available. 

 

The tool will open with a list of inputs that will need to be filled out before running. 

1. Turn Selector: Select left, right or both to specify which calculations to run. 
a) Select Major Alignment: Click the ‘Select’ button then navigate to the drawing and select the 

alignment object that corresponds with the major alignment. 

 
b) Select Minor Alignment: Click the ‘Select’ button then navigate to the drawing and select the 

alignment object that corresponds with the minor alignment. 
c) Select Roadway Elevation Surface: Click the ‘Select’ button then navigate to the drawing and select 

the surface object that contains the roadway elevations that are to be used for the analysis. 
* If no 3D analysis is desired a surface will still need to be selected but it does not have to be in the 
same geographic location as the alignments. 

d) Select Surface for Conflict Analysis: Click the ‘Select’ button then navigate to the drawing and select 
the surface object that is being reviewed for sight obstructions. 
* If no additional surface is needed, select the first surface again. This is an optional input to provide 
flexibility when performing sight obstruction analysis. If two separate surfaces are chosen the program 
will check both for obstructions. 

e) Total Number of Through Lanes on Major: Enter the total number of through lanes from both 
directions of the major road. 

f) Major Lane Width (ft): Enter the standard lane width for the major road. 
g) Total Number of Through Lanes on Minor: Enter the total number of through lanes from both 

directions of the minor road. 
h) Minor Lane Width (ft): Enter the standard lane width for the minor road. 
i) Major Median Width/Additional Width (ft): Enter the width of the median on the major road. 

* It is important to note the calculations assume that the median is centered about the alignment 
provided. If there is no median, set to 0’. 

j) Minor Median Width/Additional Width (ft): Enter the width of the median on the minor road. 



 

116 

* It is important to note the calculations assume that the median is centered about the alignment 
provided. If there is no median, set to 0’. 

k) Additional Offset from Edge of Travelway (ft): Enter any additional offset distance needed from the 
edge of travelway for items such as crosswalks, skewed intersections etc. If not needed set to 0’. 
* The default distance from the edge of travelway is set to 14.5’ per the 2021 RDM. Any distance 
specified here will be added to the 14.5’. 

l) Major Design Speed (mph): Enter the Design Speed in miles per hour. 
m) Design Vehicle: Select the appropriate design vehicle from the drop down. The parameters from the 

2021 RDM shown below are used for calculations. 
Design Vehicle Gap Time 

Right (sec)  
Gap Time 
Left (sec)  

Additional Gap Time for 
Multilane Facilities (per lane) 

Driver Eye 
Height (feet) 

Passenger Car 6.5 7.5 0.5 3.5 
Single-Unit Truck 8.5 9.5 0.7 7.6 
Tractor/Semitrailer  10.5 11.5 0.7 7.6 

 
n) Additional (tg) Minor Approach Grade, Left Turn (sec): Add any additional gap time necessary for 

the minor approach grade associated with the left turn. 
* Per the 2021 RDM if the approach upgrade on the minor road exceeds 3 percent, add 0.2 seconds for 
each percent grade. 

o) Additional (tg) Minor Approach Grade, Right Turn (sec): Add any additional gap time necessary for 
the minor approach grade associated with the right turn. 
* Per the 2021 RDM if the approach upgrade on the minor road exceeds 3 percent, add 0.2 seconds for 
each percent grade. 

p) Stationing Case Selection: Select the appropriate case for alignment stationing directions. 

  
Case 1 Case 2 

  
Case 3 Case 4 

q) Choose Layer: Select the appropriate layer from the dropdown of available layers in the drawing. The 
intersection sight distance information will be drawn on this layer.  
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Select run and the script will process and draw the intersection sight distance triangles.

 
1. The ISD triangles will appear with labels for the Eye and ISD elevation points.  
2. If the sight line intersects a surface, an additional label will appear stating there is a sight obstruction. 

This label will state which surface(s) are intersected. 

 
3. If no elevation data appears with the Eye and ISD elevation labels, there is no surface information 

present at those locations.  
4. The ISD triangle will be one polyline, and an additional 3D line will be drawn between the Eye and ISD 

point.  
5. The ISD label includes the ISD length rounded up to the nearest 5 ft.  
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Appendix A 
Objects that utilize base layer and component layers 

Alignment 
Alignment-Labeling 
Alignment Table 
Appurtenance 
Appurtenance-Labeling 
Assembly 
Building Site 
Cant View 
Catchment 
Catchment-Labeling 
Corridor 
Corridor Section 
Crossover Group 
Feature Line 
Fitting 
Fitting-Labeling 
General Note Label 
General Segment Label 
Grading 
Grading-Labeling 
Grid Surface 
Grid Surface-Labeling 
Interference 
Intersection 
Intersection-Labeling 
Mass Haul Line 
Mass Haul View 
Match Line 
Match Line-Labeling 
Material Section 
Material Table 
Parcel 
Parcel-Labeling 
Parcel Segment 
Parcel Segment-Labeling 
Parcel Table 
Pipe 
Pipe-Labeling 
Pipe and Structure Table 
Pipe Network Section 
Pipe or Structure Profile 
Point Table 
Pressure Network Section 
Pressure Part Profile 
Pressure Part Table 

Pressure Pipe 
Pressure Pipe-Labeling 
Profile 
Profile-Labeling 
Profile View 
Profile View-Labeling 
Sample Line 
Sample Line-Labeling 
Section 
Section-Labeling 
Section View 
Section View-Labeling 
Section View Quantity Takeoff Table 
Sheet 
Structure 
Structure-Labeling 
Subassembly 
Superelevation View 
Surface Legend Table 
Survey Figure 
Survey Figure-Labeling 
Survey Figure Segment Label 
Survey Network 
Tin Surface 
Tin Surface-Labeling 
Turnout 
View Frame 
View Frame-Labeling
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Appendix B 
Tips and Tricks 

• Drafting lines by bearing and distance 
For drafting lines with precise bearing and distance, several techniques can be used. This tip presents two 
foundational techniques, showing that the most suitable approach is often determined by the volume of lines to 
be created.  

Use this option when only drawing a few lines 

1. Line – Use this command to get started 
2. LINE Specify first point: - Select a location in model space 
3. LINE Specify next point or [Undo]: - Instead of selecting another point use the transparent 

command ‘BD to enter the line as a bearing and distance. 
Or 

1-3.  Select the Line drop down in the Draw Panel of the Home Tab and then select “Create Line by 
Bearing” 

 
4. BD>>Specify quadrant (1-4): - Select the appropriate quadrant (NE=1, SE=2, SW=3, NW=4) 
5. BD>>Specify bearing: - Type the bearing in (45d15'03" format) 
6. BD>>Specify distance: - Type the distance needed. 

Use this option when more lines need to be drawn or a record needs to be retained of the lines drawn. 

1. Line – Use this command to get started 
2. LINE Specify first point: - Select a location in model space 
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3. LINE Specify next point or [Undo]: - Instead of selecting another point enter the bearing and 
distance as as @distance<bearing ex: @567.54<N88D43'0"W 

4. This method can be expedited further by entering all the bearings and distances in excel and then 
copying an entire column of line information into the command line at step 3. All the lines will be drawn 
in order, starting from the top and proceeding down the column. 
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